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New Worklight Project

= Create an IBM Worklight®
project: in the toolbar, click
Create a Worklight Artifact >
Worklight Project

= QOther ways to create an IBM
Worklight project:

— Click File > New > Project >
Worklight Project > Next.

— Right-click an empty space in
the Project Explorer, and
click New > Worklight
Project.

B|@f @ imy S| ||

[ Project Explorer & &5 Worklight Adapter

P =Worklight Devel
[ Worklight Hybrid Application

B Worklight Inner Application
Worklight Shell Component
L] Worklight Native API

BE Worklight Environment
&= Worklight Application Skin

£ Worklight JSONStore
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New Worklight Project

= |In Name, type
WeatherProject.

= In Project Templates, select
Hybrid Application.

= Click Next.

800 New Worklight Project

Worklight Project

Create a new Worklight project.

v

Mame: 'WeatherP‘mject

Project Templates:

E Inner Application
O wative am

|E| Shared Templates
Shell Component

R Hybrid Application Hybrid Application

Creates a Worklight project containing an
initial Hybrid application. A Hybrid
application can target multiple
environments and is primarily written in
HTMLS, C55, IS, but can be extended with
native code. It can access device
capabilities through a JavaScript APIL.

(":J':I < Back [

Next > ] [  Cancel | Finish
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New Hybrid Application

In Application name, type
Weather.

Select Use Worklight
Application Framework
(beta).

Dojo Toolkit is selected
automatically because IBM
Worklight Application

Framework is based on Dojo.

Click Finish.

If the Open Associated
Perspective dialog box opens,
click No.
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8ano New Worklight Project
Hybrid Application
Configure the hybrid application that will be created along with the W
Worklight project.
ﬁ Hybrid Application Application name:
Weather|

Optional JavaScript Libraries: Dojo Toolkit

| -__E_n_nn figure Javnflc_r_i_;it Libraries._.._; |

IET Use Worklight Application Framework (beta)

LGonboure Emewoitibeany o)

@ A separate project called "wiFrameworkLib" will be created

lf'ﬁ)] [ <Back | Next > [ cancel || [~ Finish-
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What Was Created in the Workspace?

= Worklight project
WeatherProject (1).

— Hybrid application Weather
(2).
= application. json file: the
application model (3).
= view.html file: the
application Ul (4).
= dojoLib project: Dojo Toolkit
library (5).
= wlFrameworkL b project: IBM

Worklight Application
Framework library (6).

(75 Project Explorer 52 HE | T = 0

O oo |

¥ i) WeatherProject
P =i, Java Resources
b =i, JavaScript Resources
[=-adapters
¥ i—Z-apps
¥ (= Weather
I ¥ = common
[=-css
b = images
k= js
%] application.json
index.html
b= legal
Ejapr_'nlicaticm—descriptar.xml
build-dojo.properties

|X| build-dojo.xml
Ehuild—settings.xml

P = hin

b = server

P = services

P

I bﬂwlFramewDrkLib |
b = Worklight Development Server
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The IBM Worklight Application Framework Editor

When you create a new hybrid application that uses IBM Worklight
Application Framework, the editor of IBM Worklight Application
Framework opens.

Use this editor to edit the appl1cation. json and the view.html
files of your app.

If you close the editor, double-click the appl1cation. json file to
open it again.

The editor has three tabs (see the next slide):

Application is used to specify the general configurations of your
app.

Data Objects is used to define the data objects of your app, and
how the data maps to the back-end services.

Views is used to define your app views (screens) and the
transitions between them.
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The IBM Worklight Application Framework Editor

application.json 3 = O
Worklight Application Framework editor [
- * Application Level Events
Configure application-level events, for instance when the application starts, or is about to go
Getting started with Worklight Application Framework Into the background, e : g
[Event Function File |
i Remove
| Edit
I
Create Data Object Create a View
from Service
~ Theme

Customize the application Ul using C55

Theme: Browse...

~ Authentication

|| User Login is required:

Realm:
Mo realm specified Configure...
Automatically re-authenticate after expired session

Details:

Mo authentication

Application | Data Objects ‘ Views ‘
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Weather Application Overview

11

You build a Weather app.

The app has three views
(screens), as shown on the right.

The Home view does not access
any back-end service. This view
IS used to enter the ZIP code of a
city.

The Weather and Forecast
views pull the data for the
requested ZIP code from back-
end services.

The app uses a public weather
Web Service:
http://wiki.cdyne.com/index.php/C
DYNE_Weather

City

Stata

Températura

j—

P Description

10007 >

Show Weather »

Show Forecast >

State

Forecasi

121013, 124

12M1A3, 120

121212, 12:0

From the Home view, the user can either
go to the Weather view or to the
Forecast view.
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Data Object of the Home View

= Create a data model and a view.

— You can create the view first, or
you can create the data model
first. In this tutorial you create the
data model first.

= Switch to the Data Objects tab.

= Click DataObject (created by
default).

= Press F2 and rename the data
object Home.

13

@ *application.json &3

& Worklight Application Framework editor

* X

Data Object Definitions

FE global
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Adding a Data Attribute

14

Create a data attribute to store
the ZIP code that the user of
the app will enter.

Right-click Home data object,
and select New. The “New
field” window opens.

In Name, enter: zi1p

Select String, and click OK.

@ *application.json 232

& Worklight Application Framework editor

+ XK

Data Object Definitions

£ global
= Home
ot zip
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Creating the Home View

15

Switch to the Views tab.

Create an editable view element to
show the ZIP code. View elements that
are not tables must be placed in
sections.

Hover over view1l (created by default).
A View menu is displayed over the
view.

Click Add View Element. In the Add
View Element window, select Section,
and click OK.

Right-click FieldSection, and click Add
View Element.

In the Name field, type zip and in the
Label field, type ZIP. Select String,
and click OK.

Double-click the new zip element,
select Editable, and click OK.

Note: Names are used to identify
entities in the editor, labels are
displayed in the application UlI.

*application.json 23

Worklight Application Framework editor

»ﬂ e e — -

viewi

i
[=1
[
th

foos_ e

Double click
to add view.

© Copyright International Business Machines Corporation 2014. All rights reserved.



Creating the Home View (continued)

16

Hover over viewl. The View
menu is displayed over the view.

Click Configure View (the pencill
icon) to open the Configure
View window.

In Name, type home, and in
Heading, type Home.

In Specify how the view
elements are bound to the data
object instances at the bottom
of the window, drag zip from the
View side (left) to zip on the Data
Object side (right) to perform the
binding.

Click OK to close the window.

8006

Configure View

[Jun]]
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Configure View

Specify the data objects used by this view and mapping between data properties
and view elements.

View
MName: home
Heading: Home

Specify how the view acquires instances of the Data Objects

Data Object
dataObject

Type
Home

Operation
fv; No Operation

Specify how the view elements are bound to the data object instances

View Data Object

[ % [ home
t

srzip & zip

;E___ Eﬁaobj ect (Type Home)

[ cancel | |

OK

Hu
Jn
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Weather application overview

Building the Home view

Building the Weather view

Building the Forecast view
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© Copyright International Business Machines Corporation 2014. All rights reserved.



Creating the Weather View

18

= Create the Weather view based
on an existing web service.

= Switch to the Application tab
and click Create Data Object
from Service.

0
nll
il

[Jun]]
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@ *application.json 3

& Worklight Application Framework editor

-

Getting started with Worklight Application Framework

E =

Create Data Object Create a View
from Service
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Service Discovery

1800 Add Service Wizard

= In the Service type list, select o
We b Se rVI C e Defl n I tl O n Add back-end service to invoke from the mobile application j@
L an g u ag e (WS D L) . Service type: | web Service Definition Language (WSDL)

(=) URL: http: / fwsF.cdyne.com/WeatherWs/ Weather.asmx?wsd [+] [ Go |

= Copy the following URL, and
paste it into the URL field: - '
http://wsf.cdyne.com/Weat

¥ “@WeatherSoap12 Details
4 GetWeatherinformation

e Allows you to get your City's Weather, which

a¥iHaTds B I is updated hourly. U.S. Only
% GetCityWeatherByZIP ¥ &} GetCityWeatherByZIP
herWS/Weather .asmx?wsdl. vemery——— N
4% CetWeatherinformation ¥ {} GetCityWeatherByZIP

( :l 1 k G 8 GetCityForecastByZIP &z
I C O . 4 GetCityweatherByZIP ¥ 4= output
¥ {} GetCityWeatherByZIPResponse
¥ {} GetCityWeatherByZIPResult

= In Select Service (lower left), Gl

expand WeatherSoap12, and
select GetCityWeatherByZIP.

= Browse the Details section @ <h ) (el ) [ i
(lower right) to find out more
about the service.

= Click Next.
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Data Operation

20

In addition to attributes, data
objects have operations. The
application uses operations to
Interact with back-end services
via adapters. Operations define
the mappings between the data
attributes and the service inputs
and outputs.

Select retrieve (retrieve a
single data record from the
back-end) and click Next.

[jon]
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1806 Add Service Wizard
Data Operation @
Choose service operation to support :|§

This service will be used by the application to perform certain tasks on the data
displayed in the user interface. Specfiy the type of data operation this service provides:

| create (create data in the back-end)

I (E_'.l retrieve (retrieve a single data record from the back-end) I

|_) update (update a single data record in the back-end)
| | delete (delete data from the back-end)
(1 query (retrieve a list of data from the back-end)

| I custom (for instance “search”)

'f?\l [ <Back | [Next>=- | cancel | Finish
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Data Attributes

= Define the data attributes to
create, based on the service
iInputs and outputs.

= Select City, Description,
State, and Temperature under
output (as shown on the right).

= Click Finish.

21

18,00 Add Service Wizard :
Data Fields @
Select inputs and outputs of service to import f|§]
Service inputs and ocutputs:
= ¥ &7 GetCityWeatherByZIP
¥ |} GetCityWeatherByZIP
tozip
= ¥ <= putput
= ¥ {} GetCityWeatherByZIPResponse
Bl=E ¥ [} GetCityWeatherByZIPResult
& ofr City
] <t Description
t p 3 E
- g [ selecrall |
o RelativeHumidity ——
" Hemarics | Clearall |
o ResponseText
) & State
V., Success
EI 5",- Temperature
e Visibility
A4 WeatherlD
ot WeatherStationCity
e wind
ot WindChill
(\ajl | =<Back | N [ Cancel | | Finish |

© Copyright International Business Machines Corporation 2014. All rights reserved.



Created Data Objects

= The editor switches to the Data
Objects tab.

= Based on your selections, three
data objects were created to
replicate the structure of the
GetCityWeatherByZIP service.

= The root data object is
GetCityWeatherByZIPDO.

22

- XK
Data Object Definitions
> £ global
= GetCityWeatherByZIPDO

¥ {} GerCityWeatherByZIPResponse
¥ { } GetCityWeatherByZIPResult
sty City
5’-} Description
o State
5’-} Temperature
b B GetCityWeatherByZIPResponse-item
b & GetCityWeatherByZIPResult-item
» B Home
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Created Operation

= According to your selection, a
retrieve operation is associated with
the GetCityWeatherByZIPDO data
object.

= The service outputs that you selected
previously are mapped to the data
attributes.

= The service requires ZIP as input.
Create a global variable and map it to
the service input: drag ZIP from the
Service (right) side to global on the
Data (left) side.

= You will later assign the ZIP code
entered by the user to this global
variable.

23

Operations used for views to get things done:

Operation Service

T e |
update

delete

create

query

Operation Details

Data Service

v E global ¥ L7 GetCityWeatherByZIP
L DATE ¥ = input
£ USER_ID ¥ {} GetCityWeatherByZIP
& USER_NAME e —— e e
A — ¥ <= putput
vE CetCit\a‘WealhErByZﬁDD ¥ {} GetCityWeatherByZIPResponsi
¥ {} GetCityWeatherByZIPResponse ¥ {} GetCityWeatherByZIPResull
¥ {} GetCityWeatherByZIPResult P, & city
oy —m—— "'__:__7____7 — < Description
& Description e &r Pressure
5t,- State e —— 5t,- RelativeHumidity
_;_frTemperature —— e _;,fr Remarks

< ResponseText
o State

¥y Success

& Temperature
£ Visibility
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Discovered Service

24

= The discovered services are In
the services folder of the
Worklight project.

= Expand the services folder to
see the GetCityWeatherByZIP
service.

[75 Project Explorer 52 ==y i
b 24 dojolLib
1F’-_:_'-?1.:'.-'&.31}1ErF’rc:njeq:t
b = Java Resources
b =3, JavaScript Resources
P = adapters
F i=apps
b = hin
P = server

v :‘—} SErvices
GetCityWeatherByZIP

¥ == input
¥ {} GetCityWeatherByZIP
tozip
¥ <= output
¥ {} GetCityWeatherByZIPResponse
¥ {} GetCityWeatherByZIPResult
oty City
3’-',- Description
3*,- Pressure
o RelativeHumidity
3’-',. Remarks
3*,- ResponseText
str State
¥, Success
3’-',- Temperature
£ Visibility
M WeatherlD
3’-',- WeatherStationCity
£ wind
ot WindChill
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Generated Adapter

25

To invoke the back-end service,
an adapter was automatically
generated for your application.

The new adapter is in the
adapters folder. The name of the
adapter is SoapAdapterl.

This adapter is used whenever
the application needs to access
back-end services.

In this particular case, you set up
the Weather view to call the data
object retrieve operation when
the view opens. The operation
invokes the

Weather_ GetCityWeatherByZIP
procedure of this adapter.

Y . =
[ Project Explorer 23 = ﬂ;b =

b 24 dojoLib

b 9WentherPrﬂject

P = Java Resources
P =3 JavaScript Resources

¥ = adapters
¥ = SoapAdapterl
b SoapAdapterl-impl.js
@ buildBodyl{params, namespaces, soapEnvNs)
@ getAttributes(jsonOhbj)
@ invokeWebService(body, headers)

@ jsonToXml{jsonObj, xmlStr, namespaces)

= Weather_GetCityWeatherByZIP{params, headers)

ﬁSﬂnpAdapterl.xml

Vi apps
¥ (= Weather
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Creating the Weather View

= You discovered a service and A "spplcaton son
. Worklight Application Framework editor

created a data object based on

ItS OUtp UtS . Getting started with Worklight Application Framework
= Now, create a view by using l

. . |

this data object as a template. lﬁ

= Go back to the Application tab o Servis

and click Create a View.
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Creating the Weather View

= In Name and Heading, type:
Weather.

= Select
GetCityWeatherByZIPDO. The
view represents this data
object. The view elements are
created based on the attributes
of this data object.

= Select retrieve from the
Operation list, and click Next.
This operation is called when
the view opens.

27

8,00
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Add View

View

Create a new View

MName:

-Wenther

Heading:

Weather

The view deals with the following data object:

- CetCityWeatherByZIPResponse-item

I GetCityWeatherByZIPResult-item

E Home

When the view is shown, invoke an operation on the selected data object to obtain the data

to display;

-- No Data Object -~

| = GetCityWeatherByZIPDO

Operation:

| retrieve

@

< Back [ mext> | [ cancel | [ iFinish
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Configuring the View Elements

28

You create the view elements
that are listed in the table.

You can deselect elements that
you do not want to create by
clearing check boxes in the first
column. For this view, create all
elements.

Reorder the elements as
follows by clicking Up or Down:
City, State, Temperature,
Description.

Click Finish.

800 Add View
Import data object attributes into the new view
Select view elements to create. For each view element choose its type and
define whether it is editable. Configure the details views for table elements.
View element name View element type Editable | | |' select all .|
] | City String O -
¥ State String O | Clearall |
| Temperature String O o
Configure...
(8 escipion————— Jsang | W
| Up |
Do
() | =<Back | Next > Cancel | | Finish |
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Created View

= Switch to the Views tab. You
can see the Weather view that
you created.

= The view has a section that
contains the elements that you
selected.

29

*application.json &3

Worklight Application Framework editor

....................

Double click
to add view.

© Copyright International Business Machines Corporation 2014. All rights reserved.



Creating a Transition from the Home View to the Weather View

30

First, create a button that causes
the transition.

Hover over the home view, click
Add View Element, select
Section, and click OK.

Right-click the new FieldSection
(the second one in the view) and
click Add View Element.

In the Name field, type
showWeather, and in the Label
field, type Show Weather.
Select Button, and click OK.

Create a transition from the new
showWeather button, by
dragging the circle in front of
showWeather, on the border of
the view, to the Weather view.

*application.json 3

Worklight Application Framework editor

oy = ot )

=l FieldSe oty s )

e B b 3
ol Do
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Configuring the Transition

31

Double-click the transition to
configure it. The Configure
Transition window opens.

At the bottom of the window, you

can see the Specify how the data
from the source view is mapped
to data in the target view section.

Map (drag) the zip attribute of the
source view data object (on the left)
to the global variable ZIP (on the
right) that was created earlier.

When the transition happens, the
value of the zip attribute is
assigned to the global variable ZIP.

Click OK to close the window.

[jon]
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800 Configure Transition

Configure Transition

Specify the transition target and how data should be transferred to the target view

Should any of the Data Object instances in the "from” view be re-used in the "to" view?

Data Object Instances Re-use In Target View? Target Data Object
dataObject (Type Home) No data objects with the same type in target view

Specify how the data from the source view is mapped to data in the target view

Dara objects in "home View" Dara objects in "Weather View"
¥ E global ¥ £ global
& DATE oy DATE
A USER_ID & USER_ID
A USER_NAME oty USER_NAME
NAZIP — NAZIP
¥ | dataObject (Type Home) - ¥ £ GetCityWeatherByZIPDO (Type €
_r,t, ip——MMM———— - ¥ {} GetCityWeatherByZIPRespon:
¥ { | GetCityWeatherByZIPResu
st City
gtr Description
o State

ﬂt r Temperature
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32
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Building the Weather view
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Creating the Forecast View

33

= Switch to the Application tab
and click Create Data Object
from Service.

m *application.json 3

& Worklight Application Framework editor

-

Getting started with Worklight Application Framework

E | o

Create Data Object Create a View
from Service
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Creating the Forecast View — Service Discovery

34

In Service type, select Web Service
Definition Language (WSDL).

Select the URL you used previously
in the URL list, and click Go.

In the Select Service section (lower
left), expand WeatherSoap12, and
select GetCityForecastByZIP.

Browse the Details section (lower
right) to find out more about the
service.

Click Next.

|1®00

Add Service Wizard

Add Back-end Service

Add back-end service to invoke from the mobile application

(&

¥ % WeatherSoapl2
£8% Corilioathe

** GetCityForecastByZIP

Service type: | web Service Definition Language (WSDL)

(j} URL: Http: .?,.f;vs-F..cd‘rne.corrifi&'_éal.!'ler.‘wg.;’il‘;éaiﬁer.asmx?\;sdl [+ | “Go |
- | File: Workspace File System
Select Service:

Details

Allows you to get your City Forecast Over the
Mext 7 Days, which is updated hourly. U.S. Only
v & GetCityForecastByZIP
¥ = input
¥ {} GetCityForecastByZIP
&ozp
¥ <= output
¥ {} GetCityForecastByZIPResponse
¥ {} GetCityForecastByZIPResult
S City
b {} ForecastResult
& ResponseText
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Data Operation

1806 Add Service Wizard

= Select the data operation thatis -~ -
used to inVOke the SerVICe. Choose service operation to support §§%

This service will be used by the application to perform certain tasks on the data

o SeIeCt ret r I eve (ret r I eve a displayed in the user interface. Specfiy the type of data operation this service provides:
Slngle da‘ta record from the -;-create (create data in the back-end)
b aC k_en d ) , and CIiCk N ext . I (E} retrieve (retrieve a single data record from the back-end) I

[ | update (update a single data record in the back-end)

| ) delete (delete data from the back-end)
_ query (retrieve a list of data from the back-end)

'_;_l custom (for instance “search”™)

@) | <Back | [-oNext>| [ cancel | Finish
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Data Attributes

36

= Define the data attributes to

create, based on the service

Inputs and outputs.

= Select City, Date, Description,
DaytimeHigh, MorningLow,

and State under output (as
shown on the right).

= Click Finish.

L8000 Add Service Wizard

Data Fields @
Select inputs and outputs of service to import |EJ

Service inputs and outputs:

[=) ¥ & GetCityForecastByZIP
¥ => input

¥ {} GetCityForecastByZIP
tozp
8 ¥ <= output
= ¥ {} GetCityForecastByZIPResponse
[=1 ¥ |} GetCityForecastByZIPResult
4 ofr City
= ¥ {} ForecastResult
= ¥ [ ] Forecast
™~ & Date [ selectall |
™ e Desciption -
¥ {} ProbabilityOfPrecipiatian [ clearall |
5*,. Daytime -
& Nighttime
~ ¥ {} Temperatures
™ &y DaytimeHigh
|§I 51,- MorningLow
| A4 WeatherlD
f_t,- ResponseText
EI c},- State
Y Success
& WeatherStationCity
@ [ <Back | [ cancel | [ Finish. |
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Created Data Objects

37

= The editor switches to the Data

Objects tab.

= Based on your selections, six
data objects were created to
replicate the structure of the

GetCityForecastByZIP
service.

= The root data object is
GetCityForecastByZIPDO.

+ ¥

Data Object Definitions
£ global

b & Forecast-item
b [ ForecastResult-item

¥ {} GetCityForecastByZIPResponse
¥ {} GetCityForecastByZIPResult
oty City
¥ {} ForecastResult
¥ | ] Forecast
@T} Date
3’-',. Desciption
b {} Temperatures
e.tr State
» [ CetCityForecastByZIPResponse-item
b | CetCityForecastByZIPResult-item

3 !  CetCityWeatherByZIPLO

b B GCetCityWeatherByZIPResponse-item
b B CetCityWeatherByZIPResult-item
> & Home

|h & Temperatures-item

= GetCityForecastByZIPDO
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Created Operation

38

= According to your selection, a

retrieve operation is associated
with the
GetCityWeatherByZIPDO data
object.

The service outputs that you
selected previously are mapped
to the data attributes.

The service requires ZIP as an
input. Drag ZIP from the
Service (right) side to ZIP on
the Data (left) side, to map the
global variable to the service
input.

Operations used for views to get things done:

.Operation Service I
= e |
update
del
eeeeee
query
Oper: D I
Dat service
v £ global ¥ & GetCityForecastByZIP
& DATE ¥ = input

J,— USER_ID ¥ {} GetCityForecastByZIP

& USER_NAME

= CYZIFLAS MY spo
¥ {} GetCityForecastByZIPResponse ¥ {} GetCityForecastByZIPRes
¥ {} GetCityForecastByZIPResult e — & City
& City — ¥ { } ForecastResult
¥ [} ForecastResult v ] Forecast
[] Fore _— = — P Date
Y D — I — &y Descip
& Desciption —————— ¥ {} ProbabilityOfPr,
¥ {} Temperatures st,. Daytime
o DaytimeHigh ———— o Nighttime
& MorningLow — ——— ,______7- — ¥ {} Temperatures
& State — e —— _7_-""- —f———— !, DaytimeHig}
Tt MorningLow
N WeatherlD
& ResponseText
oty State
¥y Success
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Discovered Service and Generated Adapter Procedure

- The diSCOVGI‘ed [ Project Explorer 52 [ ﬂ;b| Y= O
GetCityForecastByZIP service :%f:m:bp |
. . . o WeatherProject
Is placed in the services folder b i Java Resources
of the Worklight project. ) Eaiascrion Resources
¥ = SpapAdapterl
= To invoke the back-end service, ¥ [ SoapAdapterl-impl.js
. @ buildBody({params, namespaces, soapEnvN5)
a new procedure is generated o getAttributes(jsonOb)
. @ invoekeWebService(body, headers)
|n SoapAd apterl @ jsonToXml{jsonObj xr:IStr namespaces)

& Weather_GetrCiryForecastByZIP(params, headers)

# Weather_GetCiryWeatherByZIP{params, headers)
“ SoapAdapterl.xml
v 5:5 apps

b i =-Weather
P = hin
b = server
b AT ErViCEs
GetCityForecastByZIP

GerCiryWeatherByZIP
P
> ﬁwlframewurkub
b == Worklight Development Server
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Creating the Forecast View

= Go back to the Application tab
and click Create a View.

= In Name and Heading, type
Forecast.

= Select
GetCityForecastByZIPDO.

= Select retrieve in the
Operation list, and click Next.

40
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Add View

View

Create a new View

MName:

Forecast
Heading:

Forecast

The view deals with the following data object:

-- No Data Object --
E Forecast-item

[ GetCityForecastByZIPDO

E- CetCityForecastByZIPResponse-item
' GetCityForecastByZIPResult-item
' GetCityWeatherByZIPDO

E CetCityWeatherByZIPResponse-item
' GetCityWeatherByZIPResult-item

£ Home

I PSR P

When the view is shown, invoke an operation on the selected data object to obtain the data

to display;

Operation:

| retrieve

@

< Back [ mext> | [ cancel | [ Finish
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Configuring the View Elements

- R d th I t ann Add View
eor er e e emen S aS Import data object attributes into the new view
i I . lect vi ; jew el i d
follows by Clicking Up OF DOWN . | e e Gt e sevsie e tor sase emene.
City, State, Forecast.
| View element name | View element type | Editable | | [ selectall.)
W] | City String [
e e, g T
[+ Forecast Table
Configure...
[ w |
| Down |
® | =Back | Next > | cancel | [ Finish J
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Configuring the Table Element

= Click the Forecast row, and
click Configure.

= Reorder the elements as
follows by clicking Up or
Down: Date, DaytimeHigh,
MorningLow, Description.

= Click Finish to close the
window.

= Click Finish to close the Add
View wizard.

42

806

Import data object attributes into the new view
Select view elements to create. For each view element choose its type and
define whether it is editable. Configure the details views for table elements.

[ View element name View ellement'type Editable | | |' selectall |
| Date Timestamp O -
[+ DaytimeHigh String O | Clearan |
] MaorningLow String O =

onfigure...
s |
| Up |
Diown
—
@ [ cancet | [ Finish |
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Created Views

43

Switch to the Views tab to see
what was created.

The Forecast view shows City,
State, and the Forecast table.

The Forecast table has four
attributes. On a small device, the

table can show only two columns.

To show all four attributes,
another view was created —
Forecast-Forecast (the
concatenation of the name of the
first view and the field name of its
table).

This Forecast-Forecast view
opens when you tap the row of
the table in the running
application.

[Jun]]
I
|||1||[|
)

I

5tr . E’g Do .
S ® o' Dayimaiis O
l ] Faorea 'E-tr' MorningLow .
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Creating a Transition from Home View to Forecast View

44

First, create a button that causes the
transition.

Hover over home view, click Add
View Element, select Section, and
click OK.

Right-click the new FieldSection (the
third one in the view) and click Add
View Element.

In the Name field, type
showForecast, and in the Label
field, type Show Forecast. Select

Button, and click OK.

Create a transition from the new
showForecast button, by dragging
the circle in front of showForecast,
on the border of the view, to the
Forecast view.

sr O
dr ()
-5tr Temperaiuna .
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Configure Transition

45

Double-click the created transition to
configure it. The Configure
Transition window opens.

At the bottom of the window, you can
see the Specify how the data from
the source view is mapped to data
in the target view section.

Map (drag) the zip attribute of the
data object in the source view (on the
left) to the global variable ZIP (on the
right).

When you run the application, the
value of the zip attribute is
assigned to the global variable ZIP.

Click OK to close the window.

[Jun]]
ALK
il
[|u||||

808 Configure Transition

Configure Transition

Specify the transition target and how data should be transferred to the target view.

Should any of the Data Object instances in the "from" view be re-used in the "to" view?

Data Object Instances Re-use In Target View? Target Data Object
dataObject (Type Home) Mo data objects with the same type in target view

Specify how the data from the source view is mapped to data in the target view

Data objects in "home View" Data objects in "Forecast View"
¥ £ aglobal ¥ £ global
o DATE o DATE
& USER_ID & USER_ID
ot USER_NAME ot USER_NAME
NAZIP — NAZIP
¥ £ dataObject (Type Home) e 2 ¥ £ GerCityForecastByZIPDO (Type

" ¥ {} CetCityForecastByZIPRespor
¥ {} CetCityForecastByZIPRes
oy City

¥ {} ForecastResult
¥ [] Forecas t
i Mara
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Agenda

Creating a project with a hybrid application
Weather application overview

Building the Home view

Building the Weather view

Building the Forecast view

Deploying and previewing
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Deploying and Previewing

Your application is ready!
Save the file (Ctrl-S).

Deploy the application:

In WeatherProject > apps, right-click Weather, and click Run As
> Run on Worklight Development Server.

Deploy the adapter:

In WeatherProject > adapters, right-click SoapAdapterl, and
click Run As > Deploy Worklight Adapter.

Preview the app:

In WeatherProject > apps, right-click Weather, and click Run As
> Preview.
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Previewing the Application

48

The first view (Home) of the
application opens.

Click ZIP to enter the ZIP code.

A view containing a data entry
field opens.

Type, for example, 10007.

Click Home in the application
heading to get back to the
Home view.

@ application.json @ Weather &3 = O
ZIP 10007 >
Show Weather >
Show Forecast >
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Previewing the Application

= Click Show Weather.

= The second view (Weather) of
the application opens.

= The data that is shown on this
view Is the result of the back-
end service invocation.

= Click Home in the application
heading to get back to the
Home view.

49

@ Weather &3 = O

@ application.json

City New York
State NY
Temperature 24
Description
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Previewing the Application

m C“Ck ShOW Forecast [ application.json @ Weather I3 = O

= The third view (Forecast) of the

application opens. City New York
. . State NY
= The data that is shown on this
view Is the result of the back- Forecast
end service invocation. 12/10113, 12:00 AM 32 ©
= To see more details about a 12/11/13,12:00 AM 30 ©
specific date, click the 12/12/13, 12:00 AM 25 ©
corresponding row in the 121313, 12:00 AM 2 ©
Forecast table.
12/14M13, 12:00 AM 36 &
- Cllck.Home In the application 1211513, 12:00 AM 2% ©
heading to get back to the
12/16/13, 12:00 AM 29 &

Home view.

50 © Copyright International Business Machines Corporation 2014. All rights reserved.



Wrap-up

51

You created a simple hybrid mobile application.
The application interacts with a public Web Service to get its data.

The adapter that invokes the Web Service was automatically generated for your
application.

By using IBM Worklight Application Framework, you created the application data
representation and the views without writing any code.

Notes:

To run the application on a device, you must create an IBM Worklight
environment for each platform. For more information about specific devices,
see the modules Previewing your application on <platform_name> under
category 2, Hello Worklight, of the tutorials and samples.

If you import the sample project that is provided with this tutorial, make sure
that you have dojoLib and wliFrameworkLib in your Eclipse workspace.
These projects are created automatically when you create a hybrid application
that uses IBM Worklight Application Framework.
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For more information

For more information about IBM Worklight Application Framework,
see the section Developing hybrid applications with IBM Worklight
Application Framework in:
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Notices
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Permission for the use of these publications is granted subject to these terms and conditions.
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:

- IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

- Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer
of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this one)
and (i) the mutual use of the information which has been exchanged, should contact:

- IBM Corporation
Dept F6, Bldg 1
294 Route 100
Somers NY 10589-3216
USA
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Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice
as follows:

- © (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. _enter the year or years_. All rights reserved.

Privacy Policy Considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
session information (generated by the application server). These cookies contain no personally identifiable
information and are required for session management. Additionally, persistent cookies may be randomly
generated to recognize and manage anonymous users. These cookies also contain no personally
identifiable information and are required.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent. For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at and IBM's Online Privacy
Statement at the sections entitled “Cookies, Web Beacons and Other
Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at

Hu
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Support and comments
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For the entire IBM Worklight documentation set, training material and online forums where you can post questions, see the IBM website at:

Support

Software Subscription and Support (also referred to as Software Maintenance) is included with licenses purchased through Passport
Advantage and Passport Advantage Express. For additional information about the International Passport Advantage Agreement and the
IBM International Passport Advantage Express Agreement, visit the Passport Advantage website at:

If you have a Software Subscription and Support in effect, IBM provides you assistance for your routine, short duration installation and
usage (how-to) questions, and code-related questions. For additional details, consult your IBM Software Support Handbook at:

Comments

We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy, organization, subject
matter, or completeness of this document. The comments you send should pertain to only the information in this manual or product and
the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your IBM business partner,
or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any way it believes
appropriate without incurring any obligation to you. IBM or any other organizations will only use the personal information that you supply
to contact you about the issues that you state.

Thank you for your support.
Submit your comments in the IBM Worklight Developer Edition support community at:

If you would like a response from IBM, please provide the following information:
Name
Address
Company or Organization
Phone No.
Email address
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